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What is PS 2000?
Pristine Sounds is a digital waveform editor. It can be 
used for editing already existing waveforms or to 
record new ones. Editing features include suppressing 
noise from analog equipment and clicks & pops from 
vinyl records. All common kinds of functions like fil-
tering, reverberation, compression etc. are also avail-
able.

PS 2000 can work with up to 64 individual waveforms 
at a time, each hosted in a unique MDI (Multi docu-
ment interface) window 

Each waveform can be up to 2Gb (Gigabyte) big. An 
Audio CD is 650 Mb (Megabyte) or roughly 0.65Gb 
so this should be enough for most people. A common 
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use for Pristine Sounds is to edit waveforms for transfer-
ring to Audio CD’s
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Loading, creating and saving 
waveforms.
To edit a waveform it must first be loaded into the 
workspace of Pristine Sounds. The most common file 
formats can be recognized, namely

• wav
• au, snd
• txt
• raw
• mp2

In Pristine Sounds, an opened waveform has a win-
dow attached to it with the name of the waveform o
the title bar. 
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Opening a pre-recorded waveform
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Waveform data can be distributed onto 2 temporary 
directories, for example on two smaller hard disks, two 
partitions or two computers connected an a network. 
Waveform data is automatically stored in the “First tem
porary directory”, and in the “Second temporary direc
tory” when it cannot fit in the first directory.

When loading a waveform, the initial data must be able to 
fully fit one of the directories; it cannot be split onto 
both. A 200Mb file cannot be split in two directories 
each capable of storing for example 190Mb. When 
applying an effect to half of such a 200Mb file, 100Mb 
of new storage space is needed. That data could be 
stored on any of the mentioned storage spaces.

Any action in PS 2000 creates an additional temporar
file for the associated data. This file must fit in any of th
temporary directories.

Opening a pre-recorded waveform

To open a waveform that already exist, enter the men
File->Open. Then select the file format, and open the
file.

The file will be analyzed and copied into the temporar
storage spaces. (Depending on the file format, it is no
necessary that the storage space is equal to the initial
size. This is because PS 2000 has an own internal da
format.) If the waveform has been opened in PS 2000
before, and it is of a *.wav format, it can be “Quick 
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Recording a new waveform
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loaded”, which is faster, and will not need a first tempo
rary file.

Recording a new waveform

An additional way to load a new waveform into the wor
space of PS 2000 is to accept data from a soundcard 
instead from a file. To do this you could either enter the
menu ‘File -> Record new waveform’ or pressing the 
record button on the tool bar beneath the menu. You w
then operate a recording tool for getting the data from 
your soundcard.

Saving a waveform

To be able to use the waveform in any other program th
PS 2000 it must be saved, converted into any of the file 
formats described below. This must be done when a 
waveform is to be burned to CD-R/RW, edited in anoth
editing program or the computer is to be turned off. 

There are a couple of ways to save a waveform, namely
whole or in pieces. To simply save the whole waveform 
it is, enter the menu ‘File -> Save’ and it will be saved 
with the same name and file format is it was loaded. If 
you wish to save with another name, please use the ‘F
> Save as...’ menu choice.
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Saving a waveform
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To save only a selected part of the waveform, you can 
make a selection of that part and enter the menu ‘File
Export selection as...’ or press the right mouse button
and choose to ‘Export selection as...’ This will only sav
in *.wav file format. (You can not export to any other 
format.)

A third way of saving is to “split and save in Audio CD
format”. This function will split your waveform and save
it in many cut-up pieces. The pieces are cut at locatio
that are extra suitable when creating an Audio CD 
because the Audio CD standard has some not-so-obv
restrictions.
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Saving a waveform
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Working with waveforms
Viewing waveforms

When you have loaded or recorded a waveform, it is 
opened in a waveform window. There you can view it 
in a variety of ways.

The waveform can be displayed in two major ways. 
Common to those are that the time line goes from left 
to right, and that the left channel is viewed over the 
right channel in a stereo waveform.

Normal view
The waveform will be displayed in the “normal view”
when just loaded or recorded. The full waveform wi
be seen. As stated previously, the time line goes fro
left to right, and a stereo waveform is divided into a
left and right channel. 
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Viewing waveforms
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A sound wave is really only variations of the sound pres-
sure in the air. The normal waveform view draws the air 
pressure as it varies in time (from left to right = from the 
beginning to the end). To see in detail how the air pressure 
varies, zoom in a little bit at a time until you cannot zoom 
in any more. This can be done with the ‘Arrow up’ key. 
To zoom out, please use the ‘Arrow down’ key. When yo
cannot zoom in anymore, every pixel on the screen rep
sent one sample of the waveform. An Audio CD which 
has 44.100 samples per second has exactly 44.100 va
tions on the waveform per second. If you zoom in max
mally you can probably see about 1000 samples in the
window which would be approximately 1/44 of a secon

If you instead zoom out maximally, it is probably not po
sible to see every variation of the waveform, and if the 
zoom out factor is greater than 200-300 samples per pix
one can instead discern the approximate volume of the 
individual parts of the audio.

To zoom in, use ‘Arrow up’ key
To zoom out, use ‘Arrow down’ key

Frequency view
A way to discern the approximate frequencies that build 
up the sound is to use the frequency view. To make up for 
the fact that the frequency view can be rather incompre-
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Using selections
hensible, its at least quite beautiful! As stated above, the 
time line goes from left to right. In the frequency view, 
the low frequencies are found at the bottom of the 
screen, and the high frequencies higher up. (Remember 
that the window is divided into two parts if you are 
watching a stereo waveform.)

A part in the picture that is dark, has a low component of 
that frequency at that time. A bright part of the picture 
has a strong component of that frequency.

As you probably notice, the picture is brightest in the 
lower parts, meaning that the lower frequencies (the 
bass) is stronger than the higher frequencies (the treble). 
When air is vibrating quicker, we are saying that the fre-
quency is higher, and when the air pressure is varying 
slower, we are saying that the frequency is lower. As we 
can see in the frequency view, the bass is more promi-
nent than the treble, and that is simply because it takes 
more energy to make something vibrate faster.

Using selections

Such an easy section! Just click on the waveform and 
drag! This is true, but whereas there are other more accu-
rate ways described down below.
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A selection can be used for many things. 

It can be used for playing
If you wish to play only a small part of the waveform in 
your speakers, you can make a selection and press the 
‘Play selection’ button on the tool bar.

A selection can be used for controlling the viewing
To view only a small part of the waveform in the wave-
form window, you can make a selection of that part and
enter the menu ‘View -> Zoom in selected’

The selection is important when applying effects
If you wish to apply an effect to only a small part of the
waveform, you make a selection of that part and enter 
effect in the appropriate menu.

When you press the ‘Ok’ button in the functions dialog 
window, you will automatically be shown an additional 
window, the “Effect mixer”. Here you can choose to app
the effect to either the waveform in full, or only your 
selected part. You can also choose to use the effect on
only one of the channels (if in stereo), and the fade in &
out time (the time it takes to fade in the effect).
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Using selections
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Playing waveforms
As with any simple thing, it can be done in a million 
strange and complicated ways.

“Playing” the waveform means that the data in the 
waveform window is sent to your soundcard and 
played through your speakers. The waveform may i
some cases be modified on the fly for the best possi
listening experience.

Real-time parameters toolbox

The soundcard will be set to the sample frequency 
the waveform, but it can be played faster or slower 
you so wish. A reason to play the waveform faster 
could be to “fast forward” the playing for a couple of
second until you reach the desired point. A reason 
play the waveform slower could be to pinpoint the 
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Between the waveform and the soundcard
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exact moment when something to happens, or to investi-
gate in depth a certain moment of time. To play the 
sound faster or slower, please use the “Real-time par
eters toolbox”. If you have closed it down, it can be 
found in the menu at ‘Special -> View real-time param
ters toolbox’. 

In the Real-time parameters toolbox you can find othe
parameters for controlling the playback. The ‘Volume’ 
directly linked to the soundcard and is the same param
ter usually found in the “Volume Control” at the  system
tray. The ‘Gain’ is a software amplification of the soun
to make it easier for you to investigate very silent 
sounds.

Between the waveform and the soundcard

Pristine Sounds has something called “Sound System
Profiles” that can be inserted between the waveform a
the soundcard. This is a real-time filtering algorithm th
tries to adjust for the fact that the total audio periphera
system may not be perfect in all kinds of computers, s
reos and speakers.

Creating a Sound System Profile
In Pristine Sounds, a Sound System Profile, consist of
calibration points along the frequency axis, ranging fro
40Hz to 10kHz. The calibration points have been stra
gically placed, according to the perception of the ear.
Pristine Sounds 2000 User Guide 16



Between the waveform and the soundcard
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The calibration is subjective; it depends on who makes 
the profile. This is because the ears of a person may just 
as well as the speakers or amplifiers be less than perfect. 
Different professional users may produce different pro-
files, that according the their experience is perfect.

The principle of creating a profile is to decide whether or 
not the 32 test tones are louder or weaker than the refer-
ence tone. The reference tone is 1kHz and is played along 
with the test tones. Depending on the response of the 
audio equipment, the sounding tones may not be equally 
loud. The resulting volume of the test tones will be used 
for creating a filter that precisely adjust for these varia-
tions.

Initially, the test tones are set to be very low (24 decibels 
weaker than reference tone). Going through the 32 tones, 
you are supposed to set the tones to be “as loud as” th
reference tone (1 kHz). It is the "as loud as" definition th
is subjective. It is very hard to compare the volume of a
very low frequency-, and high frequency tone. Especia
the low frequencies less than 200Hz are hard to estima
What you will have to think about is: Listening at the two 
pulsating tones - which one is the loudest - which one is 
the weakest? It is normal not to be able to hear the differ
ence of a decibel or two.

Press Begin. The first test tone will pulsate together wi
the reference tone. Use slider to make the test tone "a
Pristine Sounds 2000 User Guide 17



Between the waveform and the soundcard
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loud" as the ref. tone. When you are content, press "Next 
tone" to calibrate the other test tones. When you are sat-
isfied with all 32 points, press “Continue...” to continue
with the wizard. Enter a description for your profile an
save it. When you have saved it, you will have to enab
it in Pristine Sounds.

What can you expect when calibrating your equipmen
If your sound system was perfect (as well as your sub
tive decisions...) you would get 32 tones calibrated to
decibel adjustments, all lying on the 0 dB line. But this
never happens. Usually, a pair of headphones may ha
an extra strong 2-5kHz response so that you will lowe
the calibration at that band.

If you are unsure and cannot decide if the test tone is 
louder or weaker than the ref. tone, please set the cali-
bration closer to the 0dB line. 

Using a Sound System Profile
To enable an existing Sound system Profile, you can 
enter the menu ‘File -> Sound System Profiler...’. 
Browse to the Profile and enable it by checking the 
‘Enable Sound System Profiles’. The profile can also 
enabled or disabled in real-time by checking this optio
in the real-time parameters toolbox.
Pristine Sounds 2000 User Guide 18



Applying effects & functions
There are a multitude of ways to modify the wave-
form. 

Some functions may be applied to parts or to the 
whole of the waveform. Other functions cannot be 
applied to only parts of the waveform. Such functions 
would include changing the global properties like the 
sample rate, number of channels etc....

Changing the global properties of a wave-
form

Some functions affect the global properties of the 
waveform, but do not affect the actual sample data. 
Such functions include
Pristine Sounds 2000 User Guide 19



Changing the global properties of a waveform
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• Changing the sample rate
A well defined number of samples has to be trans
ferred to the soundcard every second. Normal Aud
CD waveforms have 44.100 samples per second. 
Changing the number of samples will affect the pla
back speed; if the number of samples per second 
reduced, the playback will be slower and the audio
will descend into the lower frequencies; if the samp
rate is risen, the playback will be faster and the aud
content will transcend into the higher frequencies.

(When you wish to change the sample rate withou
changing the speed of pitch, the waveform has to 
“re-sampled”, and this will affect every single sam-
ple in the waveform.)

• Changing the number of channels
A waveform in Pristine Sounds has either 1 or 2 
channels. To change a mono sound into a stereo 
sound, the waveform data will be doubled, so that
the new “left” and “right” channel both contain the 
old “mono” channel. This will not affect the audible
stereo effect of the sound; to broaden the apparen
stereo experience, special functions has to be 
applied.
To change a stereo waveform into mono, the 2 left
right channels are merged into one mono channel
This is simplest done by taking the mean out of th
two channels. However, a special function exist in
Pristine Sounds 2000 User Guide 20



Applying functions & effects to the waveform data
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the Vinyl Restoration Tool (VRT) to make this func-
tion more refined. [See ref]

It is not possible to have different sample rates in different 
parts of the waveform. Neither can one waveform has 1 
channel at one place and 2 channels at another place.

Applying functions & effects to the waveform 
data

An “Effect” in Pristine Sounds  is defined as a modifica
tion of the existing waveform data, where no samples a
added or removed. (Other functionality may change the
number of samples, for example adding or removing 
silence.) All effects also fall under the category “func-
tion”, which simply is a way to modify anything in a 
waveform.

Examples of effects are (among many others)

• Changing the volume
• Adding echoes and reverberation
• Filtering
• Removing noise & vinyl scratches

Any of these effects can be applied to the whole wave-
form or a part of it.
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Applying functions & effects to the waveform data
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To apply an effect to only a part of a waveform, make a 
selection before entering the effects dialog window, and  
after pressing ‘Ok’, use the Effect Mixer to choose 
‘Selection’.

The common interface of all effect windows
Most effects have adjustable parameters. Excluded is
example the ‘Normalize volume’ that only has the task
to rise the volume in such a way that it do not clip any
samples. The ‘Remove DC-offset’ do not have adjust-
able parameters either, as it simply apply a 5Hz high 
pass filter, thereby removing any baseline offset of the
waveform.

All effect windows have an ‘Ok’ button and a ‘cancel 
button. After pressing ‘Ok’ yet another window, the 
‘Effect Mixer’ will be displayed. In the Effect mixer you
define how to apply the effect (fade in & out times, 
channels to apply to etc.). The Cancel button will leav
the waveform untouched in its current state.

Most effects can be previewed. This mean that you ca
take a copy of  a small segment of the waveform and 
apply the parameters to that part, without affecting the
actual waveform data. This can be done any number 
times and is used when trying out which parameters m
be the optimal. [See ref] In Pristine Sounds 2000 Pro,
most effects can also be previewed in real-time, mean
that a part of the waveform is played in the backgroun
Pristine Sounds 2000 User Guide 22



Applying functions & effects to the waveform data
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at the same time you change the parameters, therefor 
hearing immediately what the outcome will be.

Real-time previewing is not available in Pristine Sounds 
2000 Light

The help file for the effect can also be accessed by press-
ing the ‘Help’ button.

Many (but not all) effects also have ‘Load’ and ‘Save’ 
buttons. There are two reasons for that. If you have fou
a particularly good set of parameters, you can save the
for later usage. A second reason for saving parameters
for the usage in “batch mode”. In batch mode (or  “Auto
matic treatments”) you can apply almost any effect in a
order, totally in groups of 8 effects. This can be done 
automatically without user assistance, and can be app
to up to 128 waveforms. When defining which effects to
“batch execute” you also need to define the actual para
eters saved by you.

Batch processing is not available in Pristine Sounds 2000 
Light

The Effect Mixer
When you have pressed the ‘Ok’ button in the effect w
dow, you will be asked to input some information abou
Pristine Sounds 2000 User Guide 23
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how to apply the effect. Usually, the effect has already 
set those parameters for you. The parameters are:

• Fade in & out time: This will set the fade in & out 
time for your effect. (This property is purely addi-
tive; if the effect is a "pitch bend" this will fade 
between the original sound and the "pitch bend" 
sound - it will not slide between notes.)

• Amount of effect: This will set the total amount of 
"effect signal and original signal" that will be mixed
together. (If set to 80% the processes signal will 
account for 80% of the result, and the original sign
20%.)

• Selection / full piece: This will define where to apply 
the effect. If you have a selection, you may apply t
either the full waveform or only the selection.

• Left / Right channel: If you have a stereo waveform
you may apply to either left or right channel or bot

• Residual output: This is an option for testing pur-
poses only. The resulting output is the difference 
between the original and the effect. 

Example:
1) When removing noise, the residual output is the 
noise itself.
2) Then applying reverb, the output will be the 
reverb part.
3) When using a filter, the output will be the added 
components only.
Pristine Sounds 2000 User Guide 24
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• Soft clipping. The internal format of the sample pro-
cessing in Pristine Sounds is 24 bits. This gives a b
headroom for converting the samples back to the C
standard of 16 bits when the processing is done. It 
implies that the samples can exceed 16 bits interna
without actually clipping. The Soft clipping options 
applies an algorithm on those extra 8 bits so the co
version goes extra smoothly. Note however that old
DirectX / ActiveMovie plugins work in 16 bit mode 
only and take care of the clipping themselves.

DirectX plugins
Pristine Sounds support a standard of effects called 
“DirectX” plugins. (Also called DirectShow or DirectMe-
dia. The last version of the standard was called Active 
Movie. So much for standardization.)

A DirectX plugin can be installed long after Pristine 
Sounds was installed. Every time PS 2000 is starting, i
searches the system for new DirectX plugin effects. If a
can be found they will be listed in the Add-ons menu. 
Alien Connections only instantiate those effects into Pr
tine Sounds. The responsibility for the accuracy and op
ability of those effects lie on the manufacturer them 
selves. In the same ‘Add-on’ menu all plugins using the
native Pristine Sounds plugin standard are listed. 
Pristine Sounds 2000 User Guide 25
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When selecting a DirectX plugin, it will be opened in a 
DirectX effect window. It is quite similar to the ordinary 
effect windows, as they have the same ‘Preview’, ‘Loa
and ‘Save’ buttons. All other buttons however are loca
to the DirectX plugin itself and are not controlled by 
Pristine Sounds.

Sometimes, some DirectX plugins are listed, but gray
out, in the ‘Add-ons’ menu. This is because the effect
cannot process the currently selected waveform. It is 
probably because the effect cannot process a wavefo
of that particular number of channels. (A stereo reverb 
cannot process a mono waveform and vice versa.)

The preview dialog window
Almost every effect can be previewed.

You can test your settings so they appear as you 
intended. This automatically takes a couple of second
of your waveform and applies the effect to it. The actu
waveform will be untouched.

This is easier than applying the effect to some part of 
waveform and making an UNDO if you are not satisfie

Real-time previewing is not available in Pristine Sounds 
2000 Light
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Applying functions & effects to the waveform data
Under the "Play original"-, and "play effect" buttons there 
are some statistics about the waveform: Maximum & 
minimum sample value, RMS. and the number of chan-
nels.

Play buttons: Press to hear either the original or the pro-
cessed version of your waveform. The "Play original" and 
"Play effect" should be obvious, but the "Play combina-
tion" deserves some explanation: This enables true A/B 
listening. Define what will be played in each channel: the 
left/right original sound or the left/right effect sound. If 
you choose left original as the output on the left channel 
you will hear the originals left channel in the left speaker. 
Choose left effect in the right speaker to hear the effects 
left channel. For example; if the effect in question is noise 
suppression, you will hear the left channel in the middle 
and some noise in the right speaker, and no (preferably:-) 
noise in the left speaker.

Stop buttons: Press to stop waveform playing.

2 / 4 / 8 seconds: The amount of time of the waveform 
that the preview will use.

Position slider: Set the actual point of testing. (This point 
will be remembered the next time you enter the preview 
window using the same effect & waveform.)
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Applying functions & effects to the waveform data
Waveform / Spectral view: Use the waveform view to 
see the waveform amplitude, or use the spectral view to 
examine the signals frequency components.

Intensity: For use with spectral view, to brighten or dim 
the view.

Graphical windows: A quick snapshot of the original 
and the processed waveform.

Volume...: Displays the "real-time parameters" toolbox.

Residual output: This is an option for testing purposes 
only. The resulting output is the difference between the 
original and the effect. 

Example:

1) When removing noise, the residual output is the noise itself.

2) Then applying reverb, the output will be the reverb part.

3) When using a filter, the output will be the added compo-
nents only.

Real-time... By pressing this button, the preview dialog 
window will fold down into a small toolbox beside your 
current effect window. You can now use the controls of 
Pristine Sounds 2000 User Guide 28



Applying functions & effects to the waveform data
the effect window and hear the result playing at the same 
time. By pressing ’Stop!’ you exit the previewing mode.

Real-time preview toolbox
The real-time preview toolbox has the following parame-
ters:

Bypass processing: Use this function to switch between 
the actual processed waveform and the original. This can 
be used for exactly pinpointing the performed work.

Left channel only: Use this function to process only one 
channel. This will make processing twice as fast when 
previewing stereo waveforms. Some effects can not use 
this trick.

Slow playing: When the CPU’s processing power is not 
enough, the playback is automatically slowed down. 
Using a really low playback rate from the start ensures 
that the rate will fluctuate less. A varying playback speed 
can be annoying, and this option makes playback con-
stantly low.
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More on special features

Undoing actions

Alas, not everything we do is right. Sometimes you will 
need to undo your actions. Pristine Sounds can remem-
ber everything you do, so that you can select an older 
state of the waveform. To undo an action, please enter 
‘Undo action’ from the ‘Edit’ menu. To reselect a newe
state, enter the ‘Redo action’ menu.

If you wish to navigate more exactly among the histor
of all states, please enter ‘Action navigator’. You will 
then be able to select among the states in a graphica
tree.

To save hard disk space, Pristine Sounds is set to de
data that belongs states that is older than 25 actions a
You can set this number in ‘Preferences’. 

Note! By setting the ‘Minimum number of states’ you 
can ensure that this number of states is guaranteed to
available. It is quite possible that a larger number of 
states also are saved than what you ask for. The reas
for this that some states are directly dependant of sta
older than the set value. In a system of non-linear edi
ing, a “state” can consist of data from many other stat
Pristine Sounds 2000 User Guide 30
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Recording a waveform

Pristine Sounds offer some functionality for recording 
through any Windows compatible soundcard. Although it 
is possible to do the sampling with Windows built-in tools 
(like soundrec.exe et al) or programs that came with your 
soundcard, it is recommended to use Pristine Sounds 
recording tool as it has some extra features. The following 
descriptions assumes that you have opened up the record-
ing tool, either by pressing on the recording button on the 
tool bar or the menu choice ‘Edit -> Record new wave-
form...’

Select your recording device
If you have more than one soundcard (or a soundcard w
more than one input devices) you can choose which on
to use. Press ‘Set properties’ to select the input device
sampling frequency and number of channels. Why can
you choose the number of bits per sample? Most soun
cards can sample with 8 and 16 bit accuracy, but the a
ity to use 8 bit samples do not serve any purpose toda
The quality is terrible. In future versions of Pristine 
Sounds there might be support for soundcards that can
sample with 18, 20 or 24 bit samples as well.

The soundcard frequency analyzer
As well as common VU meters, you can also analyze t
actual frequency content in the incoming signal. This c
be useful when tweaking the settings before recording.
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Recording a waveform
opposed to the VU meters the frequency analyzer will 
not analyze the signal after background processing, only 
data directly from the soundcard.

The soundcard frequency analyzer displays in real-time 
the content of the incoming signal. On one axis you have 
the frequency, and on the other the strength of the fre-
quency.

Hard disk space
When you record a new waveform, the data will auto-
matically be stored in the Primary temporary directory. 
(You must make sure that this space can hold the length 
of your record.) If the empty space is 5Mb or less, all 
recording will stop! (5Mb is required to ensure that Pris-
tine Sounds will work correctly.) When the file size of 
the recorded file is 2Gb or more, the recording will stop 
as well. The reason for this maximum file size is histori-
cal and built into Windows.

The VU meters
To ensure that the incoming signal is not to weak or not 
to strong, you can monitor the levels with the VU 
meters. You can also monitor the levels before or after 
background processing. (If you apply a strong filter, the 
volume may change drastically.)
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The levels will be sampled faster before recording than 
after you press ‘Start!’. 

If the incoming signal is being clipped, a warning will b
asserted and after you pressed ‘Start!’ this warning will 
persistent (it will not go away).

Background processing
To save time, some of the built in effects in Pristine 
Sounds can be applied at the very moment of recordin
The available effects use the same settings as they do
inside of the program. You will have to enter this effect
function and design a setting that you think is suitable f
the sound you are going to record.

When recording a vinyl album, suggested background 
processes are 

1) The VRT

2) Image noise suppression.

(DC offset removal is always suggested.)

You can have up to 2 background processes running at
same time. It is not guaranteed that the CPU can keep
with the incoming data. If the mean CPU utilization is 
noticeable less than 100% it is quite safe to assume th
no signal will ever be lost. If the CPU utilization is 
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between 98-100% you should remove some background 
process or apply a setting that could be simpler.

It is not possible to have one effect assigned to both 
background processes. (Although it might be possible to 
make a duplicate copy of the *.Plugin file in the plugin 
directory.)

Program switches

To start Pristine Sounds, you can either double click on 
the icon on the desktop or in the Start menu. You can 
also start the program by executing it with the Run com-
mand on the Start menu or in a command prompt.

When Pristine Sounds is started via its program name, 
extra switches are available. The switches can be used 
for sending commands to the program. 

Please note that the program “Pristine Sounds 2000.e
is just a program loader; this is not PS 2000 itself. If P
2000 is not running, the loader will start it, and then se
the command line to it via the SendMessage API. The
exit code of the loader program is the return code of t
message sent to PS 2000.

Exit codes, aka return values associated with the pro-
gram switches can be found in the file 
“remote_control.h” file in the \Extras directory.
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Because only one instance of PS 2000 can run at a time, it is 
possible to send more than one command to the program. 
Those commands will be sent to the same instance of the 
program. Please use the habit of starting up the program 
without program switches.

A call with a program switch will return when the opera-
tion has been completed if not otherwise stated.

These switches are defined for starting / sending com-
mands to PS 2000:

Filename
This will load the waveform into Pristine Sounds.

/RECORD
This will start the recording of a new waveform in PS 
2000. The currently selected parameters will be used. The 
call will return when recording has started.

/PLAY_ALL

This will play the current waveform from beginning to 
end. The call will return when playing has started.
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/STOP
This will stop all playback or recording if such was run-
ning.

/BATCHPROCESSING_RESET

This will prepare automated batch processing. All sched-
uling of files and treatments will be reset. Saving of files 
will be directed to the original directory (files will be 
overwritten). Playing of processed waveforms is dis-
abled. Files will be closed when done. This must be done 
before adding files or treatments.

/BATCHPROCESSING_LOAD_TREATMENT 
Filename

The treatment will be loaded and scheduled for batch-
processing. Only one treatment can be active at a time.

/BATCHPROCESSING_ADD_WAVEFORM File-
name

The file will be scheduled for batch processing. Up to 
128 files can be batch processed at a time. The file will 
be loaded when batch processing is started.

/BATCHPROCESSING_RUN
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The treatment will be executed. The call will return when 
all files have been processed.

/BATCHPROCESSING_ERRORCODE

This will return the error code from the processing.

/COMPUTER_UNMANNED boolean

When the boolean is TRUE the computer will be consid-
ered to be unmanned. All user interaction in the form of 
popup windows will be suppressed. Please use this switch 
with cation. You will never know when something has 
gone wrong!

/SCAN_NOISE filename

Assuming that a waveform is opened, it will be scanned 
for noise, and a noise image is created with the given fil-
name. The following defaults are used:

* >5 kHz, 25%
* 1-5 kHz, 30%
* <1 kHz, 35%
* 50 Hz, 100%
* No carving
* Release time, 90
* Overwork protection, 5

/QUIT option
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This will quit the program. When the option is SAVE all 
opened files will be saved, otherwise they are closed 
without saving.

The following example could be executed either from the 
“Run” start menu, or from the command prompt or a 
batch file:

For recording, please use the following procedure. It can 
be useful, when starting a recording on an unmanned 
computer.

“Pristine Sounds 2000.exe” /RECORD
“Pristine Sounds 2000.exe” /STOP
“Pristine Sounds 2000.exe” /PLAY_ALL
“Pristine Sounds 2000.exe” /STOP

If PS 2000 was not started, it would start at the first line. 
It would then start recording with the currently selected 
parameters. When the /STOP line is reached the record-
ing will stop. Playback will then be played from the start 
and will be stopped either when the /STOP command is 
given or when the end of the waveform is reached.
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This is the recommended procedure for batch processing:

“Pristine Sounds 2000.exe” /BATCHPROCESSING_RESET
“Pristine Sounds 2000.exe” /BATCHPROCESSING_ADD_WAVEFORM c:\temp\test.wav
“Pristine Sounds 2000.exe”  /BATCHPROCESSING_ADD_WAVEFORM c:\temp\test2.wav
“Pristine Sounds 2000.exe” /BATCHPROCESSING_LOAD_TREATMENT c:\temp\test.treatme
“Pristine Sounds 2000.exe” /BATCHPROCESSING_RUN

The procedure starts with a reset. Then the waveforms 
and the treatment are loaded, where after the batch pro-
cessing is started. The /BATCHPROCESSING_ERRORCODE could 
optionally be inserted after execution to read out the result 
of the operation. If another batch is to be processed, you 
must restart with a reset.

Understanding quick loading of files

Pristine Sounds 2000 can use “quick loading” of a wav
form if:

* It has been previously loaded into PS 2000.
* It has not been altered by another program since.
* It is a (16 bit PCM) *.wav

If this is true, it will be possible for PS 2000 to load the
file only “virtually” instead of transferring the file into a 
copy as a temporary file. This speeds up loading treme
dously if the waveform is big.
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In fact, the original file it self will be used as a temporary 
file. This mean that you can only have one copy of the 
waveform opened at a time.

If the *.wav file has never been loaded into PS 2000, or 
if the file has been altered outside the program, the 
quick-load feature will read in only the minimum 
amount of information that is needed to display it as a 
waveform in the window. When this is done, you can 
work with the waveform as usual, although PS 2000 will 
use idle time to read in the remaining information. (This 
is mentioned as “Refreshing peak file”.) Using this tec
nique, a 650Mb file can be loaded within 15 to 20 sec
onds, not using any temporary space.

Using “Skins”

PS 2000 has the ability to use “skins”. This is what co
monly is known as a bitmaped surface of the windows

Naturally, this only enhance the visual appearance; it 
will not speed up the processing...

The bitmaps you can use for skin effects can be found
the ‘\Skins’ directory under the installation directory. 

The \Skins\Windows directory contain bitmaps for the
surface of all windows.
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The \Skins\Backgrounds directory contain bitmaps for the 
background of PS 2000.

The bitmaps in the \Skins\Windows directory will be 
adjusted to the current color theme you might have. This 
will not happen to the background bitmaps.

If you wish to use your own skins, the format of the bit-
maps is:

* A Windows *.bmp bitmap
* 24 bit color
* A maximum of 16384 pixels, in any dimension (for 
example 128x128 or 256x64) It can be smaller than this, 
but not larger.

The bitmap will be tiled so you should make sure it is 
periodical.
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